Vision por Computador (1782)
Grado Ingenieria Electrénica y Automdtica Industrial
Dpto. Ingenieria de Sistemasy Automdtica. Universidad Miguel Herndndez

http://umh1782.edu.umh.es
Requisitos: - Windows XP, Windows 7,8,10 - (32-64bits)
- Microsoft Visual Studio C++ 2010 / 2013
- Libreria OpenCV instalada y configurada

Tutorial Instalacién Mads informacion en http://opencv.org

Este tutorial es para la version en inglés de Visual Studio C++ Express 2010.
También es aplicable a la version Visual Studio 2013

1) Crear el provecto:

- Ejecutaremos la aplicacién Microsoft Visual C++ 2010 y en el menu File seleccionaremos
New/Project

B Start Page - Microsoft Visual C++ 2010 Express

File | Edit WView Debug Tools Window Help

Mew » | 2] Project.. Crl+Shift -+
Open * ' File... Ctrl+M

Close Project From Existing Code...

Close Solution

Save Selected Items Ctrl45
Microsoft®

Save Selected Items As... 'ViSual C++_ 2010 Exp ress

g saveal Ctrl+5hift+5

Page Setup...

Get St

Print... Cirl+P
ew Project...
Recent Files » Welcor

Recent Projects and Solutions p penProject..

Exit Alt+F4

. I Recent Projects |_

- Nos aparecera una ventana donde seleccionaremos el tipo de proyecto (Win32 Console
Application). Le asignaremos un nombre indicando el directorio donde deseamos que se
cree el proyecto y desactivaremos la casilla ‘Create directory for solution’. No te
preocupes, ya que aun asi se creard el proyecto dentro de una carpeta con el mismo nombre
del proyecto.
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New Project

Recent Templates

Sortbyi[Defalt

Installed Templates
” Type: Visual C++
o eEe e #| ClassLibrary Visual C++
m e A project for creating a Win32 console
cr application
Win32 =% CLR Consale Apicaten Visual C++
General
F|  CLR Empty Project Visual C++
| % EmptyProject Visual C++
2| makefle Project Visual C++
m Win32 Console Apphcation Vsl C+4 ]
g Win32 Project Visual C++
=" Windows Forms Application Visual C++
Names; | ejt
Location: | D:Yvision)
Solution name: |

- Lanzara un asistente que nos guiara en los pasos para configurar el proyecto. Al pulsar
siguiente, marcaremos la casilla ‘Empty project’. Pulsando el botén ‘Finish’ ya tendremos

creado nuestro proyecto.

Win32 Application Wizard - ej1

Win32 Application Wizard - ej1

| | ‘Welcome to the Win32 Application Wizard

Owervisw These are the current project settings:

Application Settings & Console application

Click Finish from any window to accept the current settings.

After you create the project, see the project's readme. txt file for information
about the project features and files that are generated.

[_mext> ][ Fmish ][ cancsl

Application Settings

Owearview Add common header files for:

Application type:
Application Settings (O Windows appiication
(5 Console application
[@]:I18

(O Static library

Additional options
Empty project

(e ] CF )=

= ej1 - Microsoft Visual C++ 2010 Express.

File Edit View Project Buld Debug Tools Window Help

iglrr S a8 B9 - - S E | b [pebug

| |win32

S B B -

~| | [# | ArRUCO_BOARD_INFO

0 N TR T B S P e

Property Manager - 1 > 1x

2| A%
ochig | in2 |

-3 Release | Win32

augno Juwmeg 5§
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2) Opcional: Configurar el proyecto en la plataforma de 64bits

Por defecto el proyecto que creamos (Win32 Console Application) utiliza solo la arquitectura
de 32 Bits. Si utilizamos un S.0. de 64 bits y queremos desarrollar nuestra aplicacién en 64 bits,
deberemos configurarlo manualmente siguiendo las siguientes instrucciones:

Pulsaremos el botén derecho del ratén sobre nombre del proyecto ‘ej1’, desplegando el
menu contextual en el que seleccionaremos ‘Properties’.
Aparecera una ventana emergente, pulsaremos en el boton ‘Configuration Manager’.

2

Solution Explorer

e I
- Solution "ejl’ (1 project)
a4 ':’1 ejt

£H Build

b &

Rebuild

Clean

Project Only

Profile Guided Optimization
Build Customizations...
Add

References...

Class Wizard...

View Class Diagram
Set as StartUp Project
Debug

_9 Add Solution to Source Control...

9

Cut
Paste

X Remove

Rename

Unload Project
Rescan Solution

Open Folder in Windows Explorer

L) Properties

Ctri+Shift+X

Crl+ X
Cri+V
Del
F2

Configuration: | Active(Debug)

| Platform: [ActiveWin32)

Commen Properties | Debugger to launch:
« Configuration Properties .I.ocal Wi I .]
General ol
Debugging
Command S{TargetPath)
VC++ Directories
Linke: Command Arguments
P i -
Manifest Tool Werking Directory §{PrejectDir)
XML Document Generator Attach No
Browse Information Debugger Type Auto
Build Events Environment
Custom Build Step Merge Environment Yes
SQL Debugging Mo

*| | Configuration Manager... ]

Command

The debug command to execute.
"

l_A(eplal Cancelar |

Aparecera otra ventana emergente, pulsaremos en el desplegable identificado como
‘Active Solution Plataform’. Seleccionando la opcion ‘New'.

Configuration Manager

T —

)

Active solution configuration:

ﬁctive solution platform:

Debug

= |

[win32

. Project
ejl

Configuration

Debug

Project contexts (check the project configurations to build or de

Win32

!’._
\ <Edit...>

[=] win32

[=]
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— En la ventana que nos muestra, dejaremos las opciones por defecto: ‘Type of
plataform’-> ‘x64’ y ‘Copy settings from’-> ‘Win32’. Pulsaremos el botén ‘OK.
Podemos ver como ya disponemos de las dos plataformas activas (x64, Win32).

— Nota: Si lo deseamos podemos borrar la plataforma de 32 bits pulsado en la opcion
‘Edit’, pero por compatibilidad con equipos con S.0. de 32 bits no es recomendable.

— Cerraremos las ventanas pulsando ‘Close’y ‘Aceptar’.

f New Solution Platform M‘ 'Conﬁguratl'cn Manger e (2. e
Active solution configuration: _ Aetressiutionph 4+ ~
Type or select the new platform: Debug ,ﬁ;‘ ,]
164 -

Project contexts (check the project configurations to build or dtbi

Project Configuration <New...>
<Edit...>
e - v 1/

Copy settings from: "
Win32 x| !

el Debug

[¥] Create new project platforms

oK | | Cancel |

Cuando queramos construir nuestro proyecto para una plataforma u otra, lo seleccionaremos
en los desplegables disponible en la parte superior del Visual Studio.

€j1 - Microsoft Visual
File Edit View Project Build Debug Team Data Tools Test Window Help

-_“l'ﬁtﬂﬂ|&—_13_i,|4-PJ-;J-:;L|>|’[Debug -| | x64 v\l]
' P ou @ a| o SE(E%E|Hx % | @2

%

Property Manager - gjl
(2| 2 % |-

s el
1 Debug | Win32
- | Debug | x64
1 Release | Win32
+ [ Release | x64

A partir de aqui deberemos configurar cada una de las opciones de compilacién de forma
especifica para cada proyecto, tal como se vera en los siguientes apartados.
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3) Configurar el proyecto (12 vez):

Vamos a describir un método para configurar un proyecto que utilice la libreria OpenCV, que
es reutilizable en varios proyectos o programas. Por tanto distinguiremos dos casos:

1) Primer proyecto: crearemos unos ficheros especiales con toda la configuraciéon
2) Otros proyectos: reutilizaremos los ficheros anteriores, por lo que no sera necesario
repetir los pasos previos

Una vez creado el proyecto, la ventana del programa nos muestra en el panel izquierdo el
gestor de configuracion del proyecto ‘Property Manager’.

Si no estuviera visible esta ventana, la activariamos con la opcién del menu ‘View » Property

Manager’ o bien ‘View » Other Windows» Property Manager’.

NOTA: en la version VS2010 Express es necesario activar esta opcion en el Menu:

‘Tools » Settings» Expert’

NOTA: en la version VS2013 Express es necesario activar esta opcion en el Menu:

‘Tools » Customize» Pestaiia Commands’
Seleccionar ‘Menu bar’» View, Pulsar botén ‘Reset All’

En la ventana del gestor de configuraciéon (‘Property Manager’) nos mostrara la pagina creada
con dos apartados (Debug/Release). En Visual C++ tenemos dos modos de compilacion, cada
uno de ellos con una configuraciéon independiente:

e Modo Debug: el compilador afiade cédigo extra que nos ayudara a depurar los errores
de nuestro programa. Este es el modo que utilizaremos habitualmente

e Modo Release: cuando el programa estd terminado, la compilacion se optimiza
eliminando el cddigo de depuracion, obteniendo asi un ejecutable mas pequefio y mas
rapido.
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Vamos a describir la configuracion de los dos modos:

a) Configuracion modo Debug:

— Pulsaremos el botén derecho del ratén sobre nodo ‘Debug’, desplegando el menu
contextual en el que seleccionaremos ‘Add New Project Property Sheet’.

= ej1 - Microsoft Visual C++ 2010 Express

File Edit Wiew Project Build Debug Tools  Window Help

Jo R - N N R R =

bPouo@ | v %= [F %= | Hex

-| {win32

___:;.| 2 |Debug
ﬁ|j'=

Property Manager - &)1 * 01X

b |
= 7 el

R} Dcbug | sz

[ Release ||| &8  Add New Project Property Sheet...

2
B
E |
m
=]
-
o
=
=3
=
m

{'"_El Add Existing Property Sheet...

¥ Remove
Rename

Properties

— Nos abrird una nueva ventana donde asignaremos el nombre del fichero de

configuracion (opencv_debug). Pulsando el botén

‘Add’ creard el fichero de

configuracion en la carpeta de nuestro proyecto (opencv_debug.props) .

Add New Item

21X

Installed Templates Sortby: | Default

Add Mew Property Sheet

Type: Add Mew Property Sheet

Property Sheet {.props)

Add Mew Property Sheet

Creates a Visual C++ project property sheet

Mame:

Location:

file

opency_debug

| D:Wision'e) 1Y

5] (oo ]
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— Pulsaremos el botén derecho del raton obre la etiqueta ‘opencv_debug’ de 1a hoja de
propiedades del modo ‘Debug’ que hemos creado. En el menu contextual
seleccionaremos la opcion ‘Properties’. Esto abrira la ventana donde realizaremos la
configuracion del proyecto.

. . . opency_debug Property Pages mm
= ej1 - Microsoft Visual C++ 2010 Express S
File Edit WView Project Build Debug Tools Window Help ahelflls =
e e ¥ x| - - S E = Common Properties =]
A~ 5 | # 2 _L,| & —9| P |Debug Output Directory $(SolutionDir)s(Configuration)\
i . = User Macros Intermediate Director: ${Configuration)|
o ool B0 @ A | 2 5EE %2 | Hex % vz i o
| ma | [; = | @ | —3 = YC++ Directories Target Name &(Projectilame)
E_—— golcse Target Extension Jexe
.. [fProperty Manager - opency_ ikl Extensions to Delete on Clean = cdfy =, cache; . abj; ks resources; . b t; = thi .1
o 5 eneral ; :
5 | _?‘ <_>§| &+ @ | H 3y ::‘jipuzn:::uesﬁ\ehsl
E =R CH E:EE;;‘?E Enable Managed Incremental Buid Mo
5 =-{5 Debug | win32 System
=4 =) 0 Optimization
@ =] Microsoft.Cp =% Add Mew Project Property Sheet... ir;'f::::: i
A application , i
o PP #2)  Add Existing Property Sheet... -~ Command Line
T Unicode Sup - Manifest Tool
A CoreWindoy 4 Move Later in Evaluation ;?;i“"es
o
[ Release | Win32 #  Move Earlier in Evaluation XML Document Generator
wse Information
|dl Save opency_debug Cirl+5 i+ Build Events
istom Build Step
x Remove Del anaged Resources [ ey
Custom Build Toel Specifies a relative path to the output file dirsctory; can include environment variables.
Rename B ¥ML Data Generator Tool

A continuacidon modificaremos tres apartados del fichero de configuracién:

e VC++ Directories -> Include Directories
e VC++ Directories -> Library Directories
e Linker -> Input -> Additional Dependencies
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Vamos por partes:

a.1) Directorio de cabeceras:

— Editaremos la opciéon VC++ Directories -> Include Directories, pulsando sobre la flecha
azul del lateral derecho nos muestra un menu con la opcién <Edit> que pulsaremos y
abrira una ventana de edicion. Afladiremos el directorio: c:\opencv\build\include

Opcionalmente afladiremos la carpeta: c:\opencv\include

opency_debug Property Pages

Copfiguration: | MN/A Platfarm: | N/A Configuration Ma

=l Common Properties B General
- General Executable Directories £{VCInstallDir}bin; ${WindowsSdkDir)bin \NETFX 4.0 Tools
- User Magros Indude Directories indowsSdkDir)indude; $(FrameworkSDEDir)indude; | »
B C/CH+ Library Directaries rreTTSTE O ST T TS TN T T Wi STV TS0
= Lihker Source Directories g(vCInstallDir)atmfcsrimfe; $(VCInstallDir)atimfc\srcim
i i f:pliral Exdude Directories S(VCInstallDirjindude; ${VCInstallDir)atmfcindude; S{Wir
- Manifest File
- Debugging
- System
- Optimization
- Embedded IDL
- Advanced
" Command Line
|- Manifest Tool
H-Resources
H- MIDL
H- %ML Document Generator
H- Browse Information
H
H
3
3
H

Build Events
Custom Build Step

Managed Resources Include Directories

Custom Build Tool Path to use when searching for indude files while building a VC++ project. Corresponds to environment
XML Data Generator Tool variable INCLUDE,

" Include Directories s =)
EHx+)(s] |
c\opencov\build\include -

<l m | »
Inherited values:
S(VCInstallDir)include -
S(VClnstallDir)atimfc\include
S(WindowsSdkDir)include

| S(FrameworkSDKDir)\include

Inherit from parent or project defaults

| ok ” Cancel ]
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a.3) Directorio de librerias:

— Editaremos la opcién VC++ Directories -> Library Directories, pulsando sobre la flecha
azul del lateral derecho nos muestra un menu con la opcién <Edit> que pulsaremos y

abrira una ventana de edicion.

— Anadiremos el directorio especifico, aunque en nuestro caso siempre vamos a trabajar
con aplicaciones en consola Win32 independientemente de la arquitectura de nuestro

S.0.:

e Windows con arquitectura de 32 bits: c:\opencv\build\x86\vc10\lib
e Windows con arquitectura de 64 bits: c:\opencv\build\x64\vc10\lib

e Opcionalmente afiadiremos la carpeta:

Nota: Optaremos por esta segunda opcién sélo en caso de que compilemos una

aplicaciéon en un S.0 Win64.

c:\opencv\lib

= Common Properties =
- General
- User Macros

ClC++

Linker

- General

: Input

- Manifest File

: Debugging

: System

: Optimization

- Embedded IDL

- Advanced

- Command Line
Marifest Tool
Resources

MIDL

XML Document Generator
Browse Information
Build Events
[#- Custom Build Step

Executable Directories
Indude Directories

-

Exdude Directories

${YCInstallDir)bin; S{WindowsSdkDir)bin \NETFX 4.0 Tools|
c:\opencv\ build \include;$(IncludePath) |
g{VCInstallDir)atmfclib; $(VCInstallDir}ib

Imfclib; ${WindowsSdkDir)lib;

rameworkSDKDIr)\ib [+ |

FEETTTTC eI S|

(3R R

Managed Resources
[ Custom Build Tool
¥ML Data Generator Tool

:.i_-i.l.:warv Directories

2|

variable LIB.

Library Directories -

Path to use when searching for library files while building a VC++ project. Corresponds to environment

(L2 oo

‘ (1]}

Inherited values:

S(VClnstallDir)lib
$(VCInstallDir)atimfc\lib
S(WindowsSdkDir)lib

| S(FrameworkSDKDir)\lib

[¥] Inherit from parent or project defaults

i c:\ogencv\ build\xB6\vc10\lib -
| e

EHX(+)(s]

b

Macros>>

=N
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a.3) Librerias:

— Editaremos la opciéon Linker -> Input -> Additional Dependencies, pulsando sobre la
flecha azul del lateral derecho nos muestra un menu con la opcidon <Edit> que
pulsaremos y abrira una ventana de ediciéon. Anadiremos el listado de librerias de la

opencv

— Nota: En la pagina web tienes disponible el listado para varias versiones de la biblioteca

opencv_calib3d2411d.lib
opencv_contrib2411d.1lib
opencv_core2411d.lib
opencv_Tfeatures2d2411d.lib
opencv_flann2411d.lib
opencv_highgui2411d.lib
opencv_imgproc2411d.1lib
opencv_legacy2411d.1ib
opencv_ml2411d.1ib
opencv_nonfree2411d.lib
opencv_objdetect2411d.lib
opencv_photo2411d.1ib
opencv_stitching2411d.lib
opencv_superres2411d.lib
opencv_ts2411d.lib
opencv_video2411d.lib
opencv_videostab2411d.lib

|

et

[~

= Common Properties

odbe32.libjodbecp32.lib; %{AdditionalDependendes)

- Ler Embed Managed Resource Fie
Force Symbol References
Delay Loaded Dis

Assembly Link Resource

Debugging
System
Optimization
Embedded IDL
Advanced
Command Line

[#- Manifest Tool

¥ Resources

[&-MIDL

[ XML Document Generator

[#- Browse Information

[ Build Events

- Custom Build Step

[ Managed Resources Additional Dependencies

- Custom Build Tool Specifies additional items to add to the link command line [i.e. kernel32.ib]
[#- %ML Data Generator Tool

General S S <EdL..s %
User Macros Ignore Specific Default Libraries
WC++ Directories Module Definition File

B CfC++ Add Module to Assembly

[ aceptar | [ cancelor |

[ apicar ]

Additional Dependencies

opencv_calib3d248d.lib ~
opencv_contrib243d.lib E
opencv_core243d.lib
opencv_features2d248d.lib
opencv_flann248d.lib K
Inherited values:
kernel32.lib s
user32.lib =
gdi32.lib =
winspool.lib
comdlg32.lib
b
Inherit from parent or project defaults
[ 0K l l Cancel l
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b) Configuracion modo Release:

— Repetiremos los mismos pasos del apartado anterior pero sobre la etiqueta ‘Release’. El
fichero de propiedades lo llamaremos ‘opencv_release’ y en lugar de las versiones de
depuracion de las librerias de 1a OpenCV, deberemos incluir las librerias sin informacién
de depuracion:

= ej1 - Microsoft Visual C++ 2010 Express
File Edit WView Project Build Debug Tools Window Help
P S | & a9 - - S5 B Debug ~| [win32

Property Manager -opency_... = I X
B2t e ¢ |d
ERE:
=)-{5r Debug | Win32
==| opencv_debug
Microsaft,Cpp.Win32.us
!_=| Application
!_=, Unicode Suppart
= Core Windows Libraries
=[5 Release | Win32
==| Microsoft.Cpp.Win32.us
e Whole Program Optimiza
= Application
= Unicode Suppart
=, Core Windows Libraries

o
8
-
=
m
3
F
o
=]
=
=
m

opencv_calib3d2411_1ib
opencv_contrib2411.1ib
opencv_core2411.1ib
opencv_Tfeatures2d2411.1ib
opencv_flann2411.1ib
opencv_highgui2411._1ib
opencv_imgproc2411.1ib
opencv_legacy2411.1ib
opencv_ml2411._1ib
opencv_nonfree2411_1ib
opencv_objdetect2411_lib
opencv_photo2411.1ib
opencv_stitching2411.1ib
opencv_superres2411.1ib
opencv_ts2411_1ib
opencv_video2411.1ib
opencv_videostab2411.1ib

Al terminar este apartado tendremos en la carpeta de nuestro proyecto dos ficheros con toda la
configuracion que guardaremos para uso futuro:

opencv_debug .props

opencyv_release .props
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¢) Configuracién opcional

En el tutorial de instalacién de la libreria OpenCV vimos como configurar la variable de
entorno (PATH) con la ubicacion de las DLLs de la libreria. Si estamos trabajando con
diferentes versiones de la libreria o diferentes compiladores, podemos realizar esta
configuracion de forma especifica para nuestro proyecto.

— Pulsaremos el botén derecho del ratén sobre nodo principal con el nombre del proyecto
‘ej1, desplegando el ment contextual en el que seleccionaremos ‘Properties’.

.File Edit View Project Build Debug Team Data Tools Test
et e A= - AR R - RS R <aa e YN AT

'
iAo fEEmeE| =2

Property Manager - ejl
| & |
4 ;"] Chy

Add New Project Property Sheet...

Add Existing Property Sheet... t

L &d

Save ejl Ctrl+S
Rename F2

a1 Properties
L rwmsz I

- Elegiremos la Configuracion /Plataforma (Debug/Win32) que deseamos configurar.
Marcaremos la opcién ‘Debugging’y editaremos la opcién ‘Enviroment’.

Para el compilador VC2010 y arquitectura Win32 pondriamos:
PATH=c:\opencv\build\x86\vc10\bin;c:\opencv\bin;%PATH%

Para el compilador VC2010 y arquitectura Win64 pondriamos:
PATH=c:\opencv\build\x64\vc10\bin;c:\opencv\bin\x64;%PATH%

[ ej1 Property Pages ? =

Configuration: ||Active(Debug)

% ] Configuration Manager...

Common Properties Debugger to launch:
s ot Frophtier Local Windows Debugger '-'
Erlebugm‘l ! Command S(TargetPath)

CiCes Command Arguments

Linker Working Directory $(PrejectDir)

Manifest Tool Attach Ne

XML Document Generator Aute

Browse Information PATH = c:\opencv\build\x86\ve 10\bin;c:\opencv\bin %PATHY%
Build Events M Yes

Custom Build Step SQL Debugging No

Environment
Specifies the envirenment for the debugee, or variables to merge with exdsting environment.

I Aceptar Cancelar J 1 Aplicar |
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4) Configurar el proyecto a partir de una pagina de propiedades previa:

En este caso reutilizaremos los ficheros de configuracion creados en el proyecto anterior.

— Copiaremos los ficheros ‘opencv_debug .props’ y ‘opencv_release .props’, en la carpeta
de nuestro proyecto.

— En la ventana ‘Property Manager’ de nuestro proyecto, pulsando con el botén derecho

del ratén sobre las pestafias ‘Debug’y ‘Release’ afiadiremos las hojas de propiedades
correspondientes con la opcién del menu ‘Add Existing Property Sheet’

Add Existing Property Sheet X

E ej1 - Microsoft Visual C++ 2010 Express

File Edit View Project Build Debug Tools Window Help SEEEE |l:h"'ei1 "‘ > ¥ £ [E-
el o] K a9 - N - L~ [E i
g Eﬂ _J ﬁ ﬂ ﬂ | @ =2 "_L' | ""J - | b Sl L[% Elopency_release.props
ek H _ Escritorio
| WProperty Manager - ej1 -’J
o = Projects
i = 7 s e
o - | B Add Mew Project Property Sheet...
= [ Release |
7 =] Add Existing Property Sheet. ..
Remove
Rename
MNombre |Dp5ncv_dehug props V| [ Abrir l
Properties Objeto |\"\sual C++ Property Sheets (*props) v| [ Cancelar ]

- Realizaremos, si lo deseamos, la configuracién opcional de las variables de entorno
para depuracion.
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5) Aiiadir el cédigo fuente de nuestro programa:

— Descargaremos el fichero de ejemplo ‘ej1.cpp’ del blog de la asignatura. Lo copiaremos
en la carpeta creada para nuestro proyecto.

— Activaremos la vista del ‘Solution Explorer’. Menu ‘View-> SolutionExplorer’

— Sobre el nodo de la aplicacion (ej1) desplegaremos las subcarpetas y pulsaremos el
boton derecho del ratén sobre la carpeta ‘Source Files’. Seleccionaremos la opcion
‘Add/Existing Files’y cargaremos el fichero de codigo ej1.cpp.

B ¢j1 - Microsoft Visual C++ 2010 Express
Fle Edit View Project Buld Debug Tools Window Help

P S A % R R0 - -85 P [pebug ~| [winz2 3
A A ! | = 31 > | I ‘ File Edit View Project Build Debug Tools Window Help
Pl b o oW G| o SECECE e % |3 s

: T ) - - .—_' S E -
" Wsciution Expiorer - R x S Ha 4B - S b o
! B B el bouo@ @] EE % |3 -
E =g Solution eji’ (1 project)
il = T enn i
EM o el Dependencies Solution Explorer > 1%
7 [ Header Files

=

j Solution 'ej1’ {1 project)
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— A continuacioén compilaremos el programa (Ment ‘Build/Build Solution’ o F7) y lo
ejecutaremos (Menu Debug/Start Debugging’ o F5).
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